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Project Estimator is used to create cost estimates 

for projects.  The estimate bid item codes and quantities 

should be compared with the same information in the 

project proposal or plans.  Any discrepancies must be 

eliminated so that the data in the estimate and proposal 

or plans agree exactly and are accurate with what the 

project designer intends to be constructed in the field.  

These estimates can be exported and used to create 

projects in WebPrecon.  These instructions are geared 

toward creating a file for the purpose of successfully 

importing it into WebPrecon. 

 

 

 

BEFORE you begin, check your computer mouse settings and ensure that the Snap To function is 

turned off.  If this setting is not turned off, you will have annoying issues with Groups and Bid Item 

changing location every time you click on them. 

 Go to Control Panel 

 Select Mouse. 

 Click on the Pointer Settings tab.  

 Uncheck the Snap To box before Automatically move pointer to default button in dialog 

box. 

 Click Apply button.  

 Click OK. 

 

 

IMPORTANT NOTE 
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The Estimator Interface 

 

The Estimator interface displays three Panes:  the Tree Pane (left), the Information Pane (upper 

right), and the Spreadsheet Pane (lower right).   
 

 
 

The Tree Pane creates a structured format displaying the various groups in the project.  Contained 

within the group folders are the bid items and their bid history.  As different selections are made in 

the Tree Pane, the Information and Spreadsheet Panes on the right side of the screen will change to 

display the corresponding data for the item in the Tree Pane. 

 

The Information Pane is a form-like Pane that allows you to enter data about the estimate, group, or 

item.  This Pane view is dependent upon the selection that was made in the Tree Pane. 

 

The Spreadsheet Pane is a table-like Pane that allows you to view the different attributes of the 

group or individual item.  Information can also be entered from the table by entering the data in the 

cell.  This Pane view is also dependent upon the selection that was made in the Tree Pane. 

 

 Button in the Spreadsheet Pane will step into the child item or group in the Tree Pane, which 

also changes the Information Pane and Spreadsheet Pane to correspond. 

 

 Switches to the previously highlighted Tree node. 

 

 Switches to the parent of the current highlighted Tree node. 

 

 Move forward in the highlighted Tree node set. 
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CHECK FOR CATALOG UPDATES 

 

Updated catalogs are made available approximately every quarter.  Using the most recent catalog 

will make the process easier and more accurate.  It is not necessary to check for the catalog update 

every time Estimator is used, but it should be done regularly.  If you have never used Estimator and 

no catalog is associated with your version of Estimator, the process will begin automatically. 

 

 Click on the Catalog Tools tab on the tool bar. 

 

 Select Check for Catalog Updates … 

 

 
 

 Click on the Next button. 
 

 

 

 Check the box beside the catalog you want to import from the list and then click Next. 
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Instructions for Working with an Existing Estimator File 

Perform steps 1-4 and then skip to step 6. 

 

1. SAVE THE FILE 

 

 
 

Save the .est file from the source.  If it comes from ProjectWise or is attached to an email, click on 

the file to open it, and the Estimator program will start.  Depending upon how the file was saved by 

the original author, Estimator may require a password to open the file, which is “password”, in 

lower case letters.  If opening file from ProjectWise, be sure you do not have the Estimator program 

open. 

 

 
 

You will get a message that the catalog cannot be opened.  Click “OK” and keep going.  The file 

will be a Read-Only document, but that will not affect your work, because you will save the 

document for your own use and add the current catalog, which will remove any restrictions.   
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 Under the File tab, select Save As 

 Save the file with the name and in the location you want.   

 

 
 

 Close the file and the Estimator program.   

 

2. OPEN THE FILE 

 

After you have created the file, always open Estimator first and then open the file from the Open 

function under the File tab.  Do not open the file by clicking on the file itself, or it will be a “Read-

Only” document that cannot be modified.   

 

 Open the Estimator program by clicking on the Estimator icon on your desktop. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

file:///C:/Users/robert.hoagland/AppData/Local/Microsoft/Windows/Temporary Internet Files/Documents and Settings/All Users/Desktop/Estimator.lnk
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 Under the File tab, select Open and find the file you saved.  Be sure you do not use the Import 

function.   

 

 
 

The next screen after selecting Open is a local computer interface which will allow you to find the 

estimate file. 
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3. VERIFY THE CATALOG 

 

Verify that the most currently available catalog is being applied to the estimate. 
 

 Click the Edit tab. 
 

 Choose Estimate Options. 
 

 Choose Catalog. 
 

 Select the most recent catalog which will have the format KYTC_YEAR-MONTH-SY2008, for 

example, KYTC_2014-07-SY2008. 
 

 Click OK. 

 

 

4. REMOVE NAMES 

 

Click the Page 2 tab at the bottom of the upper right Information Pane.  If there are any individual 

or company names in the fields, delete them.  The Estimated By field will populate the Priced By 

field in WebPrecon which causes an error for Construction Procurement when transferring a project 

into CRLMS.  The Estimate By information is not required in WebPrecon and should be left blank.  

However, the General Summary Program, used by designers to transfer bid items and quantities to 

the General Summary plan sheet, requires a name and date in the Estimated By fields. 

 

 
 

At this point it is a good idea to save the changes that have been made so far, the new file name 

along with the correct catalog.  Click on the File tab, and then choose Save As to save the modified 

file which will be your working version of the estimate file to prepare for import into WebPrecon. 
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INSTRUCTIONS FOR CREATING A NEW ESTIMATE FILE 

Perform step 5 and proceed through the rest of the steps.   

Skip step 5 if working with an existing estimate file and proceed to step 6. 

 

5. CREATE A NEW ESTIMATE 
 

 Open the Estimator program. 
 

 Click on the File in the upper left corner of the tool bar and choose New, or 

 Click on the NEW icon  . 
 

A dialogue box appears with two choices, Blank Estimate and Highway Design Estimator 

Template.  Highlight Highway Design Estimator Template and click OK.  DO NOT USE 

THE BLANK ESTIMATE. 

  

 

 
 

The blank template appears and is ready for data entry and modification for the specific project 

estimate. 
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6. COMPLETE THE FORM 
 

Ensure that the various fields in the Information Pane (upper right half of the screen) have been 

completed appropriately, or fill them in as follows: 
 

 
 

7. EDIT GROUPS 
 

In Estimator, the term Groups is the same as Categories and Sections in WebPrecon.  Use only the 

Highway Design Estimator Template.  It has twenty available groups, but it is unlikely that every 

group will be required for any individual project.  Only the groups containing bid items should be 

retained.  The order of the Descriptions in the template is the order that should be maintained and 

FIELD NAME INSTRUCTIONS / EXAMPLES 

ESTIMATE Use the project’s item number. 

SPEC YEAR Auto-populated 08 even though this is not the actual current spec year. 

BASE DATE Auto-populated with the base date.  If created new, change to today’s date from the 

drop-down calendar menu. 

UNIT SYSTEM E = English or M = Metric 

LATITUDE OF 

MIDPOINT 

From plan sheets or use Google Earth to find approximate project midpoint: 

dddmmmss  [0863622] 

LONGITUDE OF 

MIDPOINT 

From plan sheets or use Google Earth to find approximate project midpoint: ddmmss  

[372204] 

GPS LATITUDE OF 

MIDPOINT 

Leave blank.  It may auto-populate if you enter data into the LATITUDE OF 

MIDPOINT field above. 

GPS LONGITUDE OF 

MIDPOINT 

Leave blank.  It may auto-populate if you enter data into the LONGITUDE OF 

MIDPOINT field above. 

FED/STATE PROJECT 

NUMBER 

Funding number from plan cover sheet.  It may have to be changed from the design 

funding number.  [STP BRZ 0124 or FD04 083 0036 124-125] 

DEFAULT FUND 

PACKAGE 

Leave blank. 

DESCRIPTION Route name and number, left align, all caps.  Limited to 60 characters including 

spaces.  [HINKEY ROAD (US 36)]  If printing an estimate, temporarily change the 

setting to center align. 

SOURCE CATALOG Automatically displays the current catalog in use on the estimate. 

WORK TYPE Choose from drop-down menu.  There are more choices available in WebPrecon.  If 

the required selection is not available in Estimator, it can be modified after the file has 

been imported into WebPrecon. 

HIGHWAY TYPE Choose from drop-down menu. 

URBAN/RURAL Choose from drop-down menu. 

SEASON Choose from drop-down menu. 

COUNTY (NUMBER) Choose from drop-down menu.  Do not type in entry or the file will not import. 

DISTRICT (NUMBER) Choose from drop-down menu.  Do not type in entry or the file will not import. 

ESTIMATE COST Auto-populated from bid item prices in file. 

CONTINGENCY % Auto-populates 10 or enter 15 depending on choice of project designer. 

ESTIMATE TOTAL Auto-populated based on bid item cost and the contingency percent. 
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mirrors the order in WebPrecon.  Many times the original estimate file creator will have changed 

the order or re-named the descriptions due to uncertainty about the appropriate category for some of 

the bid items.  The group descriptions should be in the following order with the exact description: 

 

GROUP  DESCRIPTION FOR BID ITEM TYPE 

0001 PAVING Items from the Paving Summary plan sheet 

0002 ROADWAY Items from the General Summary plan sheet.  The 

majority of the bid items are usually in this category. 

0003 DRAINAGE Items from the Pipe Drainage summary plan sheet 

0004 BRIDGE Items from the Structures plan sheet 
 

Each bridge on a project requires a separate group.   
 

Every bridge bid item must be specified.  There is no 

a lump sum bid item for bridges.   
 

The bridge description should be extended to include 

location information and drawing number:  
BRIDGE – CLINTON CREEK-DRAWING # 16945 
 

NOTE: This category is also used for culverts. 

0005 UTILITY Items from the Utility plan sheet 

0006 SEWER Items from the Sewer line plan sheet 

0007 SIGNING Items from the Signing plan sheet 

0008 SIGNALIZATION Items from Traffic Signal plan sheets 

0009 LIGHTING Items from Lighting plan sheets 

0010 TRAFFIC LOOPS Items involving traffic loop wire installed in road 

0011 INTELLIGENT 

TRANSPORTATION 

SYSTEMS 

Items for ITS systems  

0012 WATERLINE Items from Waterline Relocation plan sheet 

0013 LANDSCAPING Items from Landscaping plan sheet 

0014 MOWING  

0015 BLANK Should not be used. 

0016 UNKNOWN FOR 

ESTIMATOR 
Should not be used. 

0017 MISCELLANEOUS Should not be used. 

0018 TRAINEES * 

0019 DEMOBILIZATION 

&/OR 

MOBILIZATION 

Only demobilization and mobilization go in this 

group. 

0020 WARRANTY * 

 

* Trainees and Warranty may be added to the project/proposal by the Construction 

Procurement, but they are not included at the Design level.   

 

 

a. Re-number and rename the groups. 

 Click on the left side of the screen on the group to be edited, for example, Group 0001 

PAVING.  On the right screen, make any edits to the number or description.  Group numbers 

are always four digits but are not automatically associated with a specific description.  For 

example, Demobilization will always be the last group whether there are two groups or ten, 
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so in those examples it would be number 0002 or number 0010.  Descriptions must be in all 

caps or the file will not import into WebPrecon.   

 

 
 

Be sure to use the exact group description name.  After the file has been exported, another 

program, “Fix Estimator XML”, is run on the .xml file to add the required section codes.  

The Fix Estimator XML program will not recognize non-standard descriptions and, 

therefore, will not able to assign the required section code.  Without the correct section code, 

the file will not upload into WebPrecon, so it is very important that the group names are 

accurate. 

 

b. Delete unused groups except for those that will be needed later.  Even if the bid items for 

structures or waterlines have not been provided yet, it is a good idea to keep those groups so the 

section order and numbering will be correct in WebPrecon when they arrive. 

 Right click on the group name in the left side of the screen.  From the drop-down menu 

select Delete Group.   
 

 
 
 

 

 

c. Add missing groups; for example, when there are multiple bridges.   

 Right click on the group name in the left side of the screen.  From the drop-down menu 

select Insert Group.  A group that is added will automatically be populated at the bottom of 

all the existing groups with the last group number.  Put it in sequence with the order of the 

table above. 
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Be sure to re-number the remaining groups so that they are in consecutive numerical order with no 

gaps the sequence of numbers.  Neither Estimator nor WebPrecon will accept duplicate group 
numbers, but group descriptions can be repeated as needed, for example, for multiple bridges or 

different kinds of utilities within a project.   

 

Below is an example of correctly edited groups based on the information above: 

 

 

 

8. EDIT BID ITEMS 

 

 

 

Bid items may be in the wrong group, in the wrong order, or missing. 

 

a. Move a bid item to the appropriate group:  
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 Click the “+” beside the group where the bid item is located and the destination group on the 

left side of the screen if they are not open.  If there are no bid items in a group, there will not 

be “+” sign to click on. 

 Click and drag the bid item to the group.  It can be placed in bid item numerical order.  Drop 

in the item above the item where it should appear.  If you drop it on the Group ID, the item 

will be automatically added to the bottom of the list. 
 

b. Re-order the bid items: 

Bid items do not have to be in numerical order for importing the estimate file into WebPrecon to 

work properly because WebPrecon will automatically put them in order within each category.  

However, it makes it easier to locate bid items from the Plans if the bid item codes are in numerical 

order on the estimate. 

 Click and drag each individual bid item into the desired order, or 

 

 Click on one of the category rows.   

 Click on the Item header button in the lower right Spreadsheet Pane until the items are in the 

desired order (A-Z or Z-A).  This will only change the order in this Pane. 

 

 
 

 Click on the Edit button and select Renumber Using Current Order. 

 

 
 

 The bid items within the category are now in numerical order by bid item code. 

 

 
 

 Repeat for each category in the estimate 

c. Add a bid item: 

 Right click on the group where the bid item should be. 

 Choose Add Item from the drop-down menu. 
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After selecting Add Item, a blank item template appears in the Information Pane: 
 

 
 

 The fields on the right side of the screen should be populated as follows: 

FIELD NAME INSTRUCTIONS / EXAMPLES 

LINE NUMBER Auto-populated with an incremental number when 

Add Item function is used 

ITEM Enter the bid item code with a minimum of five 

digits.  Use “0’s” at the beginning of any number 

that is less than five digits: 00001 for DGA BASE. 
 

Item numbers can be selected from the drop-down 

menu using the arrow button: . 
 

Item numbers or descriptions can also be searched 

for using the find item button: . 

QUANTITY Enter the total quantity to be used. 

UNIT PRICE If there is a bid history on the item number entered, 

the price will be auto-populated from the catalog 

after the quantity has been entered.  If there is no 

bid history, enter the price from the previous year’s 

average unit bid price.  A price must be entered. 
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 To Enter a Bid Item Code Not Found in Catalog but is an active code in WebPrecon:  

 Click Edit on the tool bar and choose Estimate Options. 
 

 
 

 Uncheck the box before Only WebPrecon Items, Codes and Rounding Levels allowed. 

 Enter the new bid item information per the table above. 

 Repeat step 1 above and check the box before Only WebPrecon Items, Codes, and Rounding 

Levels Allowed. 

 

 Make sure that the ALTCODE field is blank.  A number in this field will prevent the file from 

importing into WebPrecon. 

 

d. To Add a Supplemental Description: 
 

Some items require a supplemental description in WebPrecon, and others need additional 

information to further clarify the item’s intended use or for more detail.  Clearing and Grubbing, 

for example, is required to have the acreage involved included in the description.  Sometimes 

PRICE SOURCE Auto-populated 

EXTENSION Auto-populated 

FUND PACKAGE Leave blank. 

FROM GROUP DEFAULT Ignore. 

DESCRIPTION Auto-populated if the item exists in the current 

catalog.  If it does not, see directions below to 

allow items outside of the current catalog.  Type 

name in all caps. 

ALT CODE Ensure this field is blank. 

UNIT Auto-populated unless the item is not in the current 

catalog.  Use the drop-down menu to enter the 

correct unit if it does not auto-populate. 

FIXED PRICE ITEM Check box only on: 

02600 Fabric Geotextile TY IV for Pipe 

10020NS Fuel Adjustment 

10030NS Asphalt Adjustment 

10203ND Pavement Adjustment 

OBSOLETE ITEM Leave blank. 

EXCLUDE ITEM FROM REFERENCE 

PRICE CALCULATION 

Leave blank.  Delete check if there is one. 
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there are duplicate items needed for different uses which should not be combined.  Waterline 

items frequently have precise additional details that the basic item description does not cover.  

This information can be entered at the estimate level and imported along with the rest of the bid 

item information.   

 To reveal the Supplemental Description field, grab the edge of the frame above the lower 

right Spreadsheet Pane and pull it down. 

 

 
 

 Enter the supplemental description in the designated field. 

 

 
 

e. Import an Excel File Introduction: 

 

Excel files are sometimes provided separately for a single group of bid items instead of those 

items having been included in the Estimator file with the other bid items.  Examples are Traffic 

Loops and Bridge items.  Excel spreadsheets can be modified so that they can be successfully 

imported into Estimator.  Using the click and drag function, the entire group along with all of 

the bid items can then be added to an existing estimate file.  It is also possible to enter multiple 

groups or even entire projects on a single Excel spreadsheet into Estimator using this same 

format.  This feature very helpful for Design/Build projects for which no estimate has been 

provided.  Ensure that the group number is correct for each bid item on spreadsheet to be 

imported with multiple groups. 

 

f. Edit the Excel file 

 

The Excel file, regardless of its original configuration, will need to be modified so that the 

format is exactly like the example below.  It is advisable to keep the original unchanged and 

create a copy to edit and import.  There should be no additional rows or extraneous information 
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beyond that contained in these cells.  The column headers from left to right in the first row must 

be in the following order, named exactly as they are in the illustration and following table:  

 

 
 

COLUMN HEADER COLUMN CONTENTS / EXAMPLES 

GROUP 

 

Four digit code for the group with zero’s as 

needed.  Set the field Number to Text for the 

zero’s to show up. 

LINE NUMBER Leave blank. 

ITEM 

 

Bid item code, minimum of five digits with 

zero’s as needed 

UNIT “EACH”, “LP SUM”, “TON” & etc., depending 

upon the associated unit used for the bid item 

ITEM DESCRIPTION Enter exactly as it is used in WebPrecon. 

SUPPLEMENTAL 

DESCRIPTION 

Enter if needed. 

QUANTITY Quantity of material to be used 

UNIT PRICE Do not change price from spreadsheet.  If blank, 

use most recent year’s average unit bid price 

EXTENSION Leave blank. 

GROUP SUPPLEMENTAL 

NUMBER 

Leave blank. 

FIXED PRICE LOCK ENTER Y FOR: 
 

02600 Fabric Geotextile TY IV for Pipe 

10020NS Fuel Adjustment 

10030NS Asphalt Adjustment 

10203ND Pavement Adjustment 
 

Otherwise enter N. 

 

 Remember to use all caps.  Bid item codes are a minimum of five digits so use zero’s at 

the beginning of four digit numbers.  When the Excel spreadsheet is ready for import, it 

should look like the example above the table. 

 After editing the Excel file, save and close the file.  Estimator will not import a file that 

is currently open. 

 Ensure that you do not have an existing group number in the estimate with the same 

number as the group to be imported. 
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g. Import Excel File into Estimator  

 Close all open Estimate files including the one into which you are importing the new file. 

 Under the File tab, select Import.  
 

 

 Locate the file in the local computer interface and double click the file line or click the Open 

button.   

 

 
 

A dialog box appears to ask whether it is a catalog or an estimate that is to be imported.  Click the 

Estimate radio button and then OK. 

 

 
The Estimate Import Spreadsheet Wizard dialogue box appears. 

 Click the radio button for Item Data. 

 Choose Sheet 1. 

 Click Next. 
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The following screen appears: 
 

 
 

 Click OK.   

 

 

The new group appears as an estimate. 
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 Click on the “+” beside Estimate Sheet 1.  The estimate opens with a blank Group 0001 

and the new group, in this case Group 0009, containing the Excel spreadsheet 

information in the Estimator format. 

 Open the Estimator file into which you want to add this new group and items. 

 Click and drag the group into the estimate where you want it.  If you are creating an 

entire project estimate from a spreadsheet for a Design/Build project, you can work from 

the newly imported estimate as there is no need to click and drag. 
 

 
 

 

After the new group has been dragged into the estimate, the program places it at the bottom of the 

groups and gives it the highest number of all the previously existing groups.   

 

 

 

 

 

 Renumber the newly imported group so that it is in the correct order and give the group 

the appropriate Description in the Information Pane (upper right side of the screen). 
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After entering the appropriate group number, the group is automatically and instantly placed in 

numerical order after you click in the Tree Pane on the left. 

 

 
 

 

 Close the individual estimate with the single group in it that you created from the Excel 

file.  You do not have to save it. 

 Click the File tab and choose Save As to save all of your changes on the complete 

estimate with the newly imported group. 

 

 

NOTE: Any time you open two Estimator files at the same time, each of them must have the same 

associated catalog.  If both Estimator files do not have the same catalog before they are opened, 

they will both lock-up as Read-Only files.  You cannot successfully change the catalog on the 

Estimator files while they are open simultaneously.  Open one of the files and change the catalog to 

match the other and save it.  Close the file.  Finally, open both of the files from Estimator and 

proceed to work. 
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9. VERIFY THE ESTIMATE 

 

The final step before exporting the file is to verify the estimate. 

 
 

 Click on the Edit tab and choose Verify Estimate (above), or 
 

 Use the Verify button on the toolbar at the top of the screen (below). 
 

 
 

 A report log will generate showing all of the potential issues on the estimate which may interfere 

with successfully importing the estimate.   
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a. COMMON ERROR MESSAGES 

 

Some, but not all, of these errors are legitimate problems that will prevent the file form being 

imported. 

 

“The Estimate Contingency is non-zero …”  The percentage has to be manually entered into 

WebPrecon so this error will not prevent the file from importing.  However, there should still be a 

number in this field in the estimate file. 

 

“The validity of this item [ITEM CODE XXXX] is questionable because a corresponding 

catalog item could not be found.”  If this message occurs for a bid item in the estimate that is a 

currently used bid item in WebPrecon, the estimate will still upload because WebPrecon will 

recognize the item.  This warning can be caused by bid items that have been added but have not 

been used enough or prior to the implementation of the most recent bid item catalog utilized by 

Estimator.  However, if this is an obsolete bid item in WebPrecon, the file will not upload. 

 

“The Item Unit is blank.” “The Item Code is blank.”  All required fields must be completed 

including units and prices.  

 

“The Unit Bid Price is not valid.” “The Bid History Unit Price is not valid”.  Sometimes the 

report will flag the Demobilization and Mobilization because of issues with the price.  You can 

create a reference price so that Estimator will calculate the percentage for each based on the bid 

item prices and quantities.  Follow the instructions below to correct this issue. 

 

The Tree Pane now has tiny warning symbols ( ) beside each category and bid item containing 

potential issues.  You can go directly to an individual error by double-clicking on the error row in 

the verify log. 
 

 

 

Although it will not show up as an error in the Verify Log report, WebPrecon will not upload the 

file if the Description of the route field is blank.  The description cannot exceed 60 characters 

including spaces.  When printing a hard copy of the estimate, this field should be center aligned so 

that it lines up properly with the other data.  For the purpose of importing, however, it should be left 

aligned because the center alignment uses up the character limitation in WebPrecon.   
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After addressing all of the issues, re-run Verify Estimate and use the Edit: Save As function to 

retain the changes. 

 

10. Adding a Reference Price to Mobilization and Demobilization 

 Select the bid item for Mobilization or Demobilization in the Tree Pane.  Be sure the 

quantity is set to 1 in the Information Pane. 

 Right click on the item in the Tree Pane and select Add Reference Price from the pop-up 

menu. 
 

 

 
 

 

In the Information Pane:  

 Enter a Reference Price ID description. 

 Put a check beside the Percent of Estimate. 

 Enter the appropriate percentage amount (Mobilization = 5.0 percent; Demobilization = 1.5 

percent) in the field beside the Percent of Estimate checked box. 

The Unit Price field will populate according to the percent you specified for the item.   
 

 

 

 

 Save this change. 

***** 

 

 

 

 

 

 

 

 

 

 

Enter Reference Price 

ID description. 

Check box for Percent of 

Estimate. 
Enter the percentage 

amount. 
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11. Final Checklist: 

 

1. Ensure that you are using the most recent release of Estimator. 

 

2. Ensure that you are using the most recent catalog. 

 

3. Always use the Highway Design Estimator Template.  NEVER use the Blank Estimate. 

 

4. Always use the drop down menus to select the appropriate Work Type, Highway Type, 

Urban/Rural Type, Season, County and District in the upper right Information Pane.  

NEVER type this information into these cells or the data will not be recognized when it is 

time to import the file into WebPrecon. 

 

5. Group descriptions must be in ALL CAPS and named exactly as they appear in the template.  

Also, they should remain in the same order as the template. 

 

6. Group descriptions can be repeated as needed, for example for multiple bridges and culverts 

within the same project. 

 

7. Delete groups without any bid items. 

 

8. Bid Item codes 02568 Mobilization and 02569 Demobilization should only be put in the 

DEMOBILIZATION &/OR MOBILIZATION group. 

 

9. Bide Item Code 10020NS Fuel Adjustment and 10030NS Asphalt Adjustment should only 

be put in the ROADWAY group. 

 

10. Ensure that all bid items have quantities, units and prices. 

 

11. Mobilization is only used on contracts over $2,000,000. 

 

12. Mobilization percentage is always 5%. 

 

13. Demobilization percentage is always 1.5% 

 

14. NEVER use the Item Alternate Code Field. 

 

15. Run “Verify Estimate” and correct all errors.  However, if you get the message “The 

Estimate Contingency is non-zero …” this is not a problem that needs correction. 

 


